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Overview
Landro play analyzer is, by nature, for the personal study of video: finding for yourself
the lessons contained within video recordings of your performance, whether you share
those findings with others or simply benefit on your own. That can be a totally
sufficient use of Landro, and many Landro users have absolutely no need for this
Administrator’s Guide.
But Landro is not restricted to individual use. As with many other uses of computers,
multiple people using Landro may benefit from doing so cooperatively. A school
curriculum for practicing technique and studying video of these practices can be
strengthened when the students are all using Landro for this purpose, according to
standard ways of tagging plays consistent throughout the class. And a sports program
can improve player study of their own and their opponents’ techniques and tendencies,
where the players are using the same tools and looking for the same things emphasized
by the coaching staff. In either case, Landro becomes more effective when there is some
consistency in how it is used, between multiple users and multiple computers.
It is for these group uses of Landro that this Administrator’s Guide has been written.
We’ll discuss setting up the catalog system, with a bit more detail than the User’s Guide
or the online help contains. We’ll discuss how catalog systems can be synchronized
between computers. We’ll discuss ways to share video between Landro users. And
we’ll also discuss how you manage the licenses for a large number of users and
computers.
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The Catalog System
The catalog system refers to a collection of information about how Landro expects you
to tag and analyze plays. The most important part of this information is the set of fields
that define how you catalog a play (or the entire video). The User’s Guide contains a
chapter on “The Catalog System” which presents a quick overview of how you set up
fields, and how you can save and load the catalog system as a way of transferring this
information to a different computer.
A single installation of Landro has one or more profiles. From the standpoint of
someone using Landro, a profile is just a “way I use Landro,” so that if the same
computer is used for more than one type of video analysis (say, two unrelated sports),
there is an easy way to pick which way Landro should work. Technically speaking, a
profile is simply a named catalog system: when you change profiles, you are telling
Landro to use a different catalog system until further notice.
This distinction is important to anyone administering a set of Landro computers: you
will almost certainly have multiple profiles in your Landro Personal Edition play
analyzer. When you are configuring your catalog system, you are only affecting the
current profile, not the entire operation of Landro.
A catalog system consists of the following information:
•

The template upon which the catalog system is based

•

The set of all fields for plays

•

The set of all fields for videos

•

The remembered values for list and text fields

•

Any play summaries defined for this catalog system

When you save or load a catalog system, all of that information is included; when you
switch profiles, you are switching to a different set of all of that information.
A profile is all of the information in the catalog system, plus just a bit more:
•

The name of the profile (for choosing which profile you want)

•

The folder(s) where Landro stores video

These extra pieces of information are not saved with the catalog system. The folders are
associated with a profile so that different uses of Landro can store video in different
places, but since these folders are probably specific to the computer, it doesn’t make
sense to save them with a catalog system.
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About templates
Landro includes a number of “templates,” each of which represents basically a “starting
point” for setting up a catalog system. A catalog system must be based upon some
template. Each template is a plug-in to Landro which provides these details:
•

A list of standard play and video fields, and remembered values for list fields

•

Possibly a Quick Entry tagging screen specific to the template

•

Standard play summaries, if any

•

“Saved searches:” any pre-defined results for the Analysis Center, in addition to
the Automatic Analysis results

•

Some visual elements of Landro (the background graphic, the icon to display
while running, etc.)

Landro includes templates for several popular sports. For example, Landro has a welldefined template for football (the first sport for which the original Landro play analyzer
hardware systems were sold) which defines common play situation fields for that sport,
a Quick Entry tagging screen with shortcuts specific to football situations, and so on.
The “General” template is used for video analysis that does not relate to sports, and is
the most general-purpose starting point.

About fields
A field is simply a place-holder for information that might exist for a play or for a video.
If you think of each play as some sort of “form,” with blanks to fill in different
information, a field is one of those blanks. Landro offers you a place to provide
information, which you may or may not actually use.
Landro has these fields defined for a play:
•

Name (free text)

•

Keywords (free text)

•

Highlight (a yes-or-no choice)

•

Start position (the elapsed time within the video where the play begins)

•

End position (the elapsed time within the video where the play ends)

These pieces of information are built into the Landro software and are always present,
regardless of the template or catalog system setup.
Landro has these fields defined for a video:
•

Name (free text)

•

Date (when the event or game occurred)

Like the built-in play fields, these two video fields are always present for any video.
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Beyond these built-in fields, the template your catalog system uses defines other fields.
These template fields cannot be edited or removed from the catalog system using that
template. You are able to modify the choices for lists for some of these template fields;
others have fixed lists specific to the sport.
You are free to define other fields of your own, beyond those built into Landro and
those that come with the template. You create fields to contain information that you
know you or your students will typically catalog.
To create a new play field, click “Edit Catalog System” on the Tools menu. On the
dialog that appears, click the “Customize” tab. Select the “Catalog fields” choice and
click “Configure.” Landro shows you a tree of all the fields set up in your catalog
system. Select the “Play Fields” folder in the tree, then click the “Add...” button.
The field must have a name. This is both how the field is displayed (in the All Fields
tagging screen, in Automatic Analysis, and so on) and how Landro internally
distinguishes one field from another.
You also choose the type of field: that is, what sort of input it expects. The possible field
types are:
•

List of choices (you can choose an item from a list)

•

List of players (you can choose a player from the team roster)

•

Text (you can type whatever you like)

•

Numeric (you can enter a number, within some range that you define)

The “list of players” type only applies to sports templates, and is not available in the
General template.
For the list of choices, or the list of players, you can check the “Multiple selection” box
to the right of the types. When this is checked, the list displays with checkboxes next to
each item, and you can pick zero, one or many choices for the field. When the multiple
selection box is not checked, you can only pick a single item from the list, so the choices
are mutually exclusive.
The “list of choices” type has another checkbox to the right: “Edit while tagging.” This
determines whether you want people to make up new choices of their own. If you are
setting up a fixed set of choices specific to your curriculum or program, you leave that
box unchecked, meaning that people can only use the choices set up within the catalog
system. If you want people to have the freedom to add other values to this field, check
the “edit while tagging” box. For a single-pick list, Landro will allow free typing in the
field, and simply prompt whether the user wants to add that choice. For a multiple
selection list, Landro will include a choice at the bottom to edit the list of choices.
(Within Landro Personal Edition, even if a field has “edit while tagging” cleared,
someone can still go into editing the catalog system to add their own choices. However,
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Landro Student Edition doesn’t have that ability, so Student Edition users are bound by
your decision of whether they can add choices.)
The same abilities to set up fields exist for the video itself; this is just another section of
the tree of fields you can set up. The process is the same. Also, for sports video, there
are two other, related sections in the tree: play fields per team and video fields per
team. If you’ve already used Landro for sports video analysis, you’ll have seen this
distinction within the All Fields tagging screen. Fields per team appear twice: once
applied to the focus team, and once applied to the opposing team.
You can arrange the order of fields for tagging. The dialog for configuring the catalog
system includes “Move Up” and “Move Down” buttons that let you rearrange the order
in which the fields appear. (Previous versions of Landro did not have this ability, and it
was difficult to get fields to appear in a particular order.)
Keep your field names short. Resist the temptation to be overly descriptive with your
field names, because longer names take up more space on the screen. Landro tries to fit
the whole name, which may leave little or no room for the field value itself!
A field name must be unique within the section of the tree where it appears. That is,
you cannot have two play fields both named “Type,” although there is no problem with
having a “Type” field for plays and a “Type” field for videos. However, this rule can
pose a problem with keeping field names short. For example, suppose that you have
two different main fields, and you want each of them to be followed by a related field
which is a “modifier.” You can’t call both fields “Modifier” even though that would be
the obvious way to label them. What you can do is hide part of the field name. If your
field name includes a tilde character (“~”), Landro doesn’t show that or any subsequent
part of the name on the Tagging screen. So if you have a field named
“Modifier~Concern” and a field named “Modifier~Diagnosis,” both will display on the
Tagging screen as “Modifier” but Landro can tell them apart. (Some of the template
fields in sports also use this approach.)

About play summaries
A play summary is a report, a table of play information. It essentially contrasts the
values in one play field with the values in another play field. Landro can optionally
break the report into sections on the basis of the values in a third play field.
The User’s Guide describes the Play Summary screen, and how you can create your own
play summaries. You can also set up play summaries while editing the catalog system;
this takes you to the same “Configure Play Summaries” window. Click “Add” to create
a new play summary, or choose an existing play summary and click “Edit.”
There’s not much to these. You provide a name for the play summary, and then select
the field that defines the rows and the field that defines the columns. If you want to
break the report into sections, also select the field that defines the groups.
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You have the option to include the play summary in the Analysis Center. Ordinarily
you would check this box; leave it unchecked only if you consider the play summary to
be a “special case” that isn’t typically used.

Loading and saving the catalog system
Landro Personal Edition provides a simple mechanism for saving and loading a catalog
system. On the Tools menu, choose “Save Catalog System,” then provide a name for
the file and a folder in which to save it. This stores the catalog system information
described previously in a file with a “.catsys” extension. Move that file to another
Landro computer, whether by network, removable drive or e-mail (the file is not large).
On the other Landro computer, choose “Load Catalog System” from the Tools menu,
then browse to the catalog system file. That computer’s current profile is updated
according to the loaded catalog system, and Landro restarts.
This provides a simple means of transferring a catalog system from one computer to
another. The next chapter, “Groups and Synchronization,” discusses a different, more
automated way to have multiple Landro computers keep their catalog systems
matched.
Note that when you load a catalog system file, you are essentially replacing the catalog
system you had. If, instead, you want to add the catalog system without replacing the
one(s) you have, then you need to first make a new profile, choosing the same template
as was used on the catalog system you want to load, and switch to that profile. Then
load the catalog system.

Catalog information in video files
When you tag plays and catalog them, Landro is maintaining a record of everything
you have marked for that video file. The start and end of each play is recorded, and any
fields for which you have provided some information are also recorded. This
information is all stored within the video file itself.
This design means that any Landro video file is self-sufficient. That is, if you move just
the video file (in most cases an industry-standard file such as .MP4 or .WMV), all of the
plays and field values go with it. Another Landro computer can see all of your
information, and perform the Automatic Analysis in the Analysis Center.
The video file does not contain, or depend upon, the catalog system. That is, if you have
set up a catalog system on one Landro computer, and tagged a file with that catalog
system, any other Landro computer knows every value for every field that you filled in.
However, the other Landro computer does not know about any fields you didn’t fill in,
nor does it know what other choices might be valid for a field. So, if you go into the
Tagging screen with a video file tagged on a different catalog system, the fields your
computer knows about are editable like normal, while fields your computer doesn’t
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recognize are displayed but are not editable. Simply put, Landro doesn’t know what
those fields are expected to contain, so it doesn’t let you change them.
The point here is that a computer that views Landro files does not need to have a
matching catalog system in order to understand the files. In fact, the Landro Presenter
companion product doesn’t have any provision for loading or syncing a catalog system,
and it still fully understands the files and performs Automatic Analysis for you. The
catalog system is primarily to aid in tagging and cataloging; if you plan to do that on
multiple computers, then you should share the catalog system.
The video file does know the template from which its catalog system started. Landro
assumes that if you open a file edited using a different template, it probably doesn’t
make sense for you to edit it. For example, Landro set up for basketball is probably not
the right profile for editing a video previously edited in Landro set up for football. So if
the templates don’t match (between your current profile and the video you are looking
at), Landro doesn’t allow you to do any cataloging at all. Also, for any video whose
template doesn’t match yours, Landro displays a label at the end of that line on the
Videos screen identifying the template used in that video.
These restrictions are meant to keep you from accidentally mixing up the tagging of a
video between different computers or different profiles. However, Landro allows you
to deliberately change the remembered profile in a file. Select a file in the Videos
screen; then, on the Tools menu, choose “Allow Edits.” This causes Landro to reassign
the video file to your current template, so that you are free to edit it. (There may still be
unrecognized field values that carry over from the old catalog system, but these won’t
keep you from editing the values that do apply to your current catalog system.)
You can also save out a table of the field information in a file. Select a file in the Videos
screen, then click on the “All Plays” line at the top of the Analysis Center. One of the
menu choices is “Save Play Data;” this saves out the plays and their catalog data as a
spreadsheet. (Actually you can save out play data for any combination of plays offered
by the Analysis Center; choosing “All Plays” simply means you get everything within
that file.)
Landro does not provide a way for you to rename a field in the catalog system. This
may seem like an odd oversight; however, this is by design. Simply put, since the value
is stored according to the field name, if you were to change the field name, any videos
with existing values for that field would suddenly become unknown fields to Landro,
able to be displayed but no longer edited. This is in fact what happens if you delete a
field from your catalog system. The important fact to take from this is: if you are going
to create a catalog system for widespread use, give some careful thought to your field
setup before you share it. Sure, you can change the catalog system at any time, and the
techniques in the next chapter make it easy to give everyone your updates... but when
you take a field away, you are taking away everyone’s ability to modify, or even
remove, any field values they had set before.

10

Groups and Synchronization
The previous chapter talked about the catalog system, and the related concept of
profiles. In this chapter we’ll talk about Landro group codes, which provide a means of
letting a number of related Landro computers keep catalog systems and profiles in
common.
A group code is nothing more than a short identifier for some related Landro users.
This is made up of no more than eight letters (typically a useful abbreviation of the
school or group to which it applies), followed by four digits, such as
“MYSCHOOL1234.” If you purchased a Landro system package or a discounted
quantity of Landro licenses, we assigned a group code to your school at the time of the
purchase, and included that information in the e-mail that included your activation
codes.
A group code is an opportunity to keep all the computers using that code in sync with a
common set of profiles. You don’t have to do this, of course; nobody with a single
license for Landro would bother with this, and we don’t even issue group codes with
single purchases because there’s no point.
In this chapter we’re going to use an example to help explain group codes and
synchronization. In this example, you are the administrator of the MYSCHOOL1234
group code. In your school, Example University, Landro is used as part of the
curriculum in the Juggling class and also in the Knife Throwing class, in both cases to
study technique from video. Generally speaking, there isn’t much overlap between
people in the Juggling class and people in the Knife Throwing class, and each class has
different things they are looking for while studying video.
Now, if only one Landro computer were being used for these tasks, you might
reasonably assume that you should create both a Juggling profile and a Knife Throwing
profile, to keep these tagging situations distinct. So far, so good. But your school has
half a dozen lab computers running Landro Personal Edition, and there are dozens of
student computers with Landro Student Edition... and now you have a problem.
Because to get the catalog system to everyone, you need to save out a Juggling catalog
system file and save out a Knife Throwing catalog system file, and then get those files
loaded onto every lab computer (creating the two profiles and loading the saved .catsys
files into each as appropriate), plus get either or both file to every student computer and
support them through the creation of profiles and the installation of the file. And then
when the curriculum for either class changes and the catalog system is updated, you
suddenly have to do it again. And that’s not even counting the challenges any time a
new student enters the program with a new computer, or a computer has Landro
reinstalled after repairs. With all of this work to do, Landro suddenly does not look
easy from your standpoint!
Well, this is what group codes are all about. Basically, we’re going to set things up so
that any computer that installed Landro with the MYSCHOOL1234 group code
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automatically gets both the Juggling and Knife Throwing profiles, without you having to
manage it... and if you update one of those profiles, all the computers will also get the
update.

Working with group codes
First, you need to have a group code. Again, if you bought Landro in a package we
already assigned a group code to you. If you don’t have one, or don’t want to use the
one we gave you, you can make another.
Group codes are stored on the Internet. You access your group code(s) through the
Landro web site. In your web browser, go to the Landro web site at
http://www.landro.com and click on the “Sign In” link in the upper right corner. You
sign in using your e-mail address, and a password you created. To use a group code we
assigned, you need to sign in using the same e-mail address to which the licenses were
originally sent when you purchased Landro. If you have not yet selected a password
for accessing Landro with your e-mail address, Landro asks you to choose a password.
Once you are signed into the Landro web site, several pieces of account information are
displayed: whatever personal information we have for you, any Landro products you
own (that we have associated with that e-mail address), your e-mail subscription
choices, and so on. At the bottom of this list is a mention of whether you are part of any
groups, and a link to “manage groups.” Click this link.
The Landro web site then lists any groups with which your e-mail address is associated.
(You may not be part of any groups, especially if you are using an e-mail address we
didn’t previously know about.) There is also a link to “Create a new group.” If you
want a new group code, use that link; Landro will ask you for a name for the group
(such as “Example University” in our example) and an abbreviation of no more than
eight letters. (Landro randomly assigns the number portion of the group code.) If you
create a new group code, then it will be added to the list of groups on this page.
In our example, you would click on the “MYSCHOOL1234” group.
There’s not a lot you can do with a group, besides change the name if you like. The
important part of the group is that it can contain profiles that you want to sync with all
computers in the group.

Profiles in groups
In our example, you want there to be a “Juggling” profile, and also a “Knife Throwing”
profile, both automatically shared with any computers associated with this group. The
first thing to do is create each catalog system.
Start by making a profile on your Landro Personal Edition with a name like “Juggling
test.” We suggest including something like “test” in the name because it’s the profile
where you work on the catalog system, a distinction that will make more sense shortly.
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Either create a new profile, or edit your existing profile, to have such a name. (The
“Juggling test” profile would be based upon the General template.) Set up your catalog
system with whatever fields and values are useful for the Juggling class curriculum.
Save the catalog system to a .catsys file as described in the previous chapter.
Now, go back to the Landro web site, sign in and go to your group code. You want to
have a Juggling profile in that group code. If you just created the group code, the page
will say “Profiles: 0” and you’ll need to create one. However, if we assigned the group
code when you bought Landro, the page may say “Profiles: 1” and list a standard profile
(perhaps “(General),” meaning an unnamed profile for the General template), and you
would need to edit it.
In either event, whether you create it or edit it, you want MYSCHOOL1234 to have a
profile named “Juggling” that uses the General template. Type in the name, make sure
the template is correct, and click the “Save Changes” button.
At this point, the Internet already knows that you want everyone in the
MYSCHOOL1234 group to have a profile named “Juggling.” In fact, if a second later
some computer started up Landro with that group code, Landro would immediately
download this information and make sure that such a profile exists. (There’s more
about this in the next section.)
But you don’t just want the profile to exist, you want it to match your saved catalog
system. So the next step is to go edit the Juggling profile in MYSCHOOL1234 again.
This time, on the line that says “Catalog system file,” pick the name of your .catsys file
(the Browse button makes it easier to find, although you could type the full path to the
file yourself). Click the “Upload” button to transfer your catalog system file into the
Juggling profile.
At this point, the Internet not only knows that everyone in MYSCHOOL1234 is to have
a profile named “Juggling,” but also knows the entire catalog system that is to go with
that profile. The next time a computer starts up Landro with that group code, it will
immediately download the catalog system along with the profile.
And of course, in our example, we want to do the same thing for the Knife Throwing
class. Create a “Knife Throwing test” profile on your Landro Personal Edition
computer, set up the catalog system, save it to a .catsys file, go to the MYSCHOOL1234
group on the Landro web site, create a new profile named “Knife Throwing” using the
General template, then edit it to upload the .catsys file.

Synchronized profiles
What you have done by these steps is created the knowledge within the Internet of two
profiles, and their catalog systems, for the MYSCHOOL1234 group code.
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Every time Landro starts up, it checks in with the Internet, to see if there are any
automatic software updates needed, and also to see if there are any new profiles or
catalog systems needed.
When Landro Personal Edition or Landro Student Edition was installed, the setup
process asked for a group code. If MYSCHOOL1234 was used at that time, then that
Landro already knows that it is a part of that group. Beyond that, you can always add
another group code if you need to: on the Tools menu, choose “Group Codes,” a simple
window where you can add (or, if you like, remove) a group code. That is, if you
created a new group code of your own, you’ll need to tell people to add it to their
Landro in order to be a part of that group.
So, between the initial install and any manual additions of group codes, Landro knows
what groups it “belongs to.” When Landro checks with the Internet, it automatically
finds out if there are new profiles or catalog system updates that it needs for its groups.
Landro downloads and sets up this information silently (unless it happens that there is
an update to the catalog system for the profile that you are currently using, in which
case Landro has to restart).
The profiles downloaded from the Internet look and behave just like profiles you
created yourself, with one minor exception: the group name is built into the profile
name. So, the computer that has synced to MYSCHOOL1234 would have a profile
named “Juggling - Example University” and a profile named “Knife Throwing Example University.”
Now, assuming that the computer where you originally set up the profiles is also part
of the MYSCHOOL1234 group, it too will receive these new profiles the next time
Landro starts. Which means you would end up with these four profiles:
Juggling - Example University
Juggling test
Knife Throwing - Example University
Knife Throwing test
The profiles ending in “test” are, of course, the ones we created, while the ones ending
in “Example University” are the synced profiles from the Internet.
Now, this would seem a bit redundant, since at the moment the two Juggling profiles
are identical, and the two Knife Throwing profiles are also identical. But what this does
is allow you to work on further updates to either profile, using the “test” versions, before
you are ready to share those updates with the rest of the group. In the previous chapter
we mentioned some problems with changing and removing fields after you’ve defined
them. So when you are working on changes, it is probably best to be able to “play
with” a profile and see how you like the changes, yet still be able to switch over to the
“official” version of the profile any time you need to do work within the catalog system
that everyone else has.
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If you don’t want or need the repeats, delete the profiles you created. (Don’t delete the
profiles that came from syncing with the Internet. You can, of course, but as long as
those profiles are on the Internet, next time you restart Landro they will come right
back.)
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Sharing Video
If you are managing a number of people using Landro, one of the issues that you’ll
probably need to consider is how they share video. We’re not talking here about the
“Share” feature within Landro, which is really mostly about converting selected plays or
video into some form more convenient for giving to someone else. Rather, we’re
talking about how one Landro user gives video to another user.
This chapter presents a number of approaches; the best method(s) depend upon the
particular needs and capabilities of your school.

Transfers via USB sticks
The method we’ve been recommending for longest with Landro is to use a USB stick or
a USB hard drive as a temporary location for video being moved between computers.
In this model, video files typically live on the hard drive of each Landro computer,
where they are used most often. This works well for Landro Student Edition, where the
primary user of the video is the primary or only user of the computer. In those cases
where the video file needs to go to someone else, it is copied onto a USB drive, and that
drive is moved to the other computer.
The simplest way to do this is to use the “Copy Video” function within Landro. With
the USB drive connected to your computer, select the video to be copied in the Videos
screen. From the menu, choose “Copy Video” (or press Ctrl+C). Landro prompts for
where you want the copy to go; choose the “External drive” option and select the
appropriate drive (if there is more than one choice). Landro transfers the selected file to
the USB drive, storing it automatically within a “Landro Videos” folder on that drive.
When the copy is complete, use the Windows mechanism for safely removing the drive,
then plug the USB drive into the other Landro computer.
If the second computer was running Landro when you plug in the USB drive, it will ask
you about this action: you could view the video(s), or you could copy the video(s) to
that Landro computer. If you only want to briefly watch the video, and the USB drive is
fast enough, the first choice is good, and Landro will show the available video(s) on the
Videos screen. But if you want the second computer to retain the file (or if the USB
drive is not fast enough for smooth playback), choose to copy the file(s) into Landro.
(Landro will next ask where the video(s) should go, defaulting to your usual video file
location.)
Note that this automatic behavior depends upon the video files being in a “Landro
Videos” folder on the external drive. If you simply transferred the videos into a
different folder or the root of the drive (say, using Windows Explorer), Landro won’t
automatically offer to do anything. However, you can still manually open a file on an
external drive. From the File menu choose “Open” (or press Ctrl+O) and browse to the
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file you want; Landro will ask whether you want to copy the file in to your normal file
locations, or play it where you found it.

Keeping files on USB sticks
A variation on the previous approach is where an external drive (USB stick or USB hard
drive) is the normal place where video files live. That is, video files don’t typically
reside on the computer’s hard drive at all, and the drive containing files is handed
around as needed. This is one approach for a “lab computer” where different users
work on the same computer but have no need (or perhaps no right) to see each others’
videos.
The only tricky thing about this approach is that when importing (or recording) video,
the external drive has to be connected to the Landro computer, and you have to
manually choose the external drive as the place where you want the import (or
recording) to go. But Landro not only displays options when you plug in an external
drive, as mentioned in the previous approach, but you can also pick an external drive at
any time from the folder list on the Videos screen as a place to select video. (You don’t
have to use “Set up folders” for this to be true; Landro automatically adds external
drives with a “Landro Videos” folder to the list of folder choices.)

Reaching across a network
One approach to accessing videos from another computer is to use a network, where
the computer containing the videos is set up with a “share” that allows its files, in
specified folders, to be readable across a local network.
In this approach, when you want to access a file from another user, you use the “Open”
command on the File menu (or Ctrl+O) and browse to the network location where the
file lives on the other computer. As always, Landro asks whether you want to copy the
file or play it where it is. Playing a file across a network is usually a bad idea unless
you have a nice fast network connection (ideally not wireless).
Unlike previous versions, Landro 2010 takes steps to safely lock files on a network
against concurrent alterations. That is, if someone is tagging a video, another user on a
network will not be able to begin tagging the same video. (The second user is, however,
still able to view the video being used.)
Do not use the approach of sharing Landro videos across a network unless you want
people on the network to freely see each others’ videos. That is, if confidentiality is any
part of your management concerns, then this is not the way to go. Further, make sure
that the shares set up for this purpose only allow reading files, not writing; a writeable
share is unnecessary if you’re just viewing and copying, and it presents a security
vulnerability for the computer if arbitrary computers (possibly containing a computer
virus!) are free to modify files.
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Network folders
Since you can set up your own choice of folders where Landro stores (and looks for)
video, you have the ability to make a network location be a “standard place” for
Landro... or even the preferred location.
In this approach, you might have a departmental or school file server set up with a
share for “dropping off” videos for someone else (say, where students put video they
want their instructor to review). In the folder pick list on the Videos screen, choose “Set
up folders” and add a new folder using the network path to this share. (Network paths
take the form “\\servername\sharename,” possibly with additional folders following
the share name.)
As noted for the previous method, networks are not always a good way to watch video,
because of speed issues. (Most networks don’t reliably run anywhere near their rated
speed, because traffic from other users can reduce the speed. This is especially true
with wireless network connections.) For this reason Landro includes an option for
folder setup for slow connections. If you check the “slow connection” box on a folder
setup, Landro will still list the videos when you choose that location, still perform
Automatic Analysis on the play data, list the folder as a copy destination and so forth,
but will not preview, play or tag video in that location (or allow you to record to it).
That is, Landro treats the folder only as a drop-off; to do any work with the file, you
need to transfer it to another folder that isn’t a slow connection. (Which Landro offers
to do.)
Of course, if you have a high-speed wired network that doesn’t bog down with traffic,
then there is no problem with a network folder being used for playback as well. Just
recognize that this may be a problem, and we can’t support performance issues when
you are using a network location for playback.

Network drives per user
If your network can handle video transfers despite traffic, and if your network includes
school-defined user accounts and access policies, then one transfer option is to set up
network storage for specific user accounts, then set up the login policies for that user
account to map a drive letter to their specific network storage location, and set up a
Landro folder to use that drive letter.
Suppose that a school has set up such a share per user in a department. User account
JSMITH has a private network storage location in \\TRAINING\VIDEOS\JSMITH,
while other users have similar locations. The JSMITH login on school lab computers
maps drive letter U: to \\TRAINING\VIDEOS\JSMITH, while mapping drive U: to
other users’ locations as appropriate. Knowing this, you could set up Landro to use
drive U: as the first (preferred) folder location. Each different user login would use the
same drive letter to reach a different, user-specific storage location.
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This approach requires more Windows administration to accomplish, but allows a
shared “lab computer” to be used by different people while never providing any user
with unauthorized access to the videos of someone else.
Meanwhile, if an instructor is authorized to see any student’s video within that
department, the instructor’s computer might be configured with a Landro folder that
points to \\TRAINING\VIDEOS and includes sub-folders, which would immediately
provide the instructor with access to any student’s videos simply by choosing a folder
from the pick list.
These suggestions are by no means exhaustive; rather, it is our intent to provide
suggestions of how videos can be shared within Landro, so you can make the choices
best for your school or facility.
We can tell you one approach to not bother trying, though: e-mail. Video files are much
too large to work well as e-mail attachments, it’s very slow, and most mail systems will
disallow attachments above certain size limits (which game or session video can easily
exceed).
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Managing Licenses
If your school has purchased a number of copies of Landro Personal Edition, Landro
Student Edition and/or Landro Presenter, or students at your school have purchased
Landro Student Edition copies associated with your school group code, it can be hard to
keep track of everything.
The Landro web site provides the tools to help you manage this. Sign in with your email address through which the Landro licenses were originally purchased, and in the
account information page, click on “View Landro products.” This page presents a list of
the products and their activation codes.
Where applicable, the products page also includes “Download” buttons to retrieve the
download file for a particular product. If you want to do the download on a different
computer, you can simply copy and paste the link associated with the button; you don’t
need to be signed into the Landro web site or be on a particular computer to use these
links.
Further, each activation code shows whether it is “available” or “in use.” Each Landro
license can only be used on a single computer, and once it is installed it shows as “in
use” until it is uninstalled. (Once uninstalled, the license can then be used to install on a
different computer.) If you bought several licenses, this screen tells you at a glance
which codes are still available to be installed.
When a license is in use, it may also display a brief line about who used that license last,
and when. As part of the “check in” Landro does with the Internet to find out whether
there are version updates or group code sync changes, Landro also saves the user login
and the computer name to the Internet. This is what is being displayed here; this
information should help you to identify which particular computer and/or user has a
particular license in use.
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